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Chapter 1:

Introduction
OVERVIEW

his manual is to accompany a two day introductory course to

MapMakerGratis, a free! yet capable software package for vector
Geographical Information Systems. Geographical Information Systems or GIS
is a vast topic, certainly more than what can be covered in a short workshop.
But that does not prevent you from learning the basics. This workshop
assumes that you are familiar with techniques such as compass traverse and
sight level mapping. If not, you need to read the field methods manual which
accompanies this booklet.

WHAT IS GIS ?

eographical Information Systems, are a computer intensive system com-

bining geographical (spatial) and information (database). For a long time,
GIS was only accessible to rich organisations, largely because some kinds of
GIS require a great deal of computer space and processing power. Things are
different today, computers are much faster and store far greater data than ear-
lier. Software too is cheaper, in fact there are a large number of free GIS pack-
ages, such as MapMaker Gratis.

Information

Geograph
/,_g phy

e

Figure 1.1: Defining GIS

1. MapMaker Pro is the commercial version of the package which costs about $300 for a site
license. In other words, your entire school or college could use Map-Maker Pro for that amount,

a small fraction of the cost of other GIS packages.



There are two basic types of Geographic information systems raster and vec-

tor.

Raster GIS is based on pixels small boxes of colour, which are combined to
make an image. This is quite similar to photographs on some newspapers,
where dots are used to create the image, see figure 1.2. Thus the following set
or matrix of numbers could also be represented as a 9 column by four line pic-
ture with 4 shades of grey (or four shades of blue if we have a colour print

1122121313 |3|4]4
1122121313 |3|4]4
1122121313 |3|4]4
1122121313 |3|4]4

Figure 1.2: Defining GIS |

Note that the fifth row is a repeat of
the first because in some GIS pack-
ages, this is used to let the software
know that the object is a closed poly-
gon (we will talk more about this
later). Thus in summary, raster GIS is
based on a matrix of numbers which
fill the entire area of interest. Vector
GIS, on the other hand, is based on a
set of vertices which are connected by
straight lines or curves. Many of the
better and newer GIS packages can
use both raster and vector GIS.

GIS AND DATA

ata is to GIS what a cable connec-
tion is to a TV. Sure you can still
watch a few programmes without a
cable, but probably not the ones you

out).

Vector GIS is based on storing a set of
points or vertices that define a point,
line, or space. Just like raster GIS these
are usually just a collection of num-
bers. Thus a square or rectangle can be
represented by four pairs of numbers -
the x and y coordinates of each point.

Figurel.4: A Vector Image
with its representation

X Location Y Location
46 91
46 18
213 19
211 96
46 91
a . E—
— —— ]

want to see. While you can use a GIS to draw, what you are producing is noth-
ing more than pretty pictures. It is only when you add data to the map that
you are “doing” GIS. Vector GIS uses a combination of spatial and non-spatial



data. This enables us to map areas according to attributes other than their
locations. For example, colouring all houses belonging to a particular income
group in a city in red or colouring roads in accordance to the traffic they carry.

Spatial data refers to the x,y and z
coordinates of what you are draw-
ing. GIS packages are good at spa-
tial calculations. In other words
they are able to measure distances,
areas and relationships between
two points in terms of their dis-
tances.

Non-Spatial Data does not refer to
specific locations. For example a
crop like paddy. You might say that
a particular field has paddy on it
but paddy itself does not refer to a
location, the field however does.
Non-spatial data is also called
attribute data because it provides

additional information about a

spatial location.
Scanning Maps

Once you have a map, you need to scan it so that the computer can read it.
This is the basic step required to be able to begin digitising. Scanning maps is
really easy, most “computer centres” will have a scanner. If your map is very
large you can take it to one of the CAD shops in town.

There are a couple of things you need to know about scanning maps:

* Make sure they are scanned at 300 dpi (dots per inch) and in colour if the
map is in colour.

* Ensure the map is placed correctly, with the Northern side up. If it is rotat-
ed by accident or because of the shape of the map, get the shopkeeper to re-
orient it to North. This will save you a lot of time.

* Ensure the scanned file is saved as an uncompressed tiff (tagged image file
format) and in a jpeg (joint photographic experts group) format.

* Please make sure the files are saved on a CD and NOT on a floppy. Floppies
have the habit of getting corrupted and waste a lot of time.

* Test the medium before you pay up, not on the CD writer used to burn the
CD but on a normal CD-Rom drive. Very often the person doing the scanning
forgets to close the CD or does not create it using standard method.

Once you have the desired map on a CD, you are ready to roll.



Getting data for your GIS

project
There are a number of places which offer various kinds of data that is useable
for a GIS project. See table 1.1:

Table 1.1: Getting Maps

Sl. No | Location/ Contact Kind of Data
FERAL Campus
Plot 170/3
Morattandi Village, | All kinds of maps and satellite photographs,
1 | Tiruchitrambalam including Pondicherry, Vanur and
Panchayat, Marakannam.
Vanur Tk. 604 101
Contact : Anupama
. Various kinds of paper and satellite maps,
French Institute
2 largely from the Western Ghats and also of
Contact: Balu . .
the Pondicherry region.
Various small maps and interesting informa-
3 |PTDC&TDC tion about Pondicherry. A good place to get
started for a project on Pondicherry.
The largest makers of maps in the country
. with maps of almost all regions.
4 | Survey of India Unfortunately Pondicherry is a restricted area
and we can 't get “topo-sheets” for it.
5 Institute of Remote | Have a wide range of maps, both paper and
Sensing, Chennai digital, of our area.
Your favourite Book store almost always have guide maps,
6 maps of roads, rails and tourist destinations.

book shop

These are a great starting point.
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Chapter 2:

Using MapMaker for Vector GIS

Mapmaker is a fairly powerful and very user friendly vector GIS package. It
comes in two flavours, MapMaker Gratis - which is free, so you are free to use
and distribute copies to your friends and cohorts. The Pro version of
MapMaker is not free, but is much cheaper than many equivalent packages,
also you can use the features of MapMaker Pro as a trial version for a month.
We will cover the following sections in this part of the course:

1. Playing with the tools
2. Digitising on a blank layer
3. Mapping from satellite data
4. Mapping from an aerial photo
5. Mapping from a scanned map
6. Editing in Map Maker
7. Using Map Furniture
8. Linking field surveys to a GIS
9. Working with databases
10. Thematic mapping

You must have a computer
-I in front of you to be able to
proceed from here.

PLAYING WITH THE TOOLS

pen MapMaker by double-clicking on the icon L_‘EH_-J
Oor shortcut in windows. The map maker window (figure ??) appears. Let
us now go through the various parts of the screen in a little detail. The menu
bar is a floating bar on the top left of the screen. The menu bar (figure 2.2)
has six drop down menus which we will use continuously during our work
with MapMaker.

Figure 2.2:
MapMaker’s Menu Bar

MAF MAKER . | =]x
File Edit Mawigate Tools LUilities Help




The toolbar (figure 2.3) is the next item on the window. The vertical bar com-
prises of a number of tools that you will use for digitising and editing maps.

Figure 2.3:
MapMaker’s Tool Bar

Navigation in MapMaker is done using pan buttons

. ¥ on either side of the scroll bar on the right. Linked to
=" ") the panning buttons are the various zooming facili-
Zoom ties that allow you to digitise more accurately. These
7 are located on the bottom right corner of the screen
Tape (figure 2.4).
|I|
Data J il
.4
Fnlyﬁ ll
Line ¥ Figure 2.4: ' T
+ MapMaker’s Zoom Bar _ _ -
Sywmbal -
U =
Edit ol
i
Selec’tJ s qﬂ}'_@@
Cutter
Join
ong L Figure 2.5
£ The Scale Bar

of the screen for the scale and posi-

tion information (figure 2.5).

Flnally look at the lower left corner i 100 200 300 400 500 BOD
] | — — — i
1:10,000 metres

We will discuss scale in greater detail later. The position tells you where you
are on the map as it appears to MapMaker.

DIGITISING
Now let’s draw some points, lines, circles, polygons etc. Most of the draw-

ing and editing tools are accessible from the toolbar. More are available
from the Tools--> Drawing menu.

ﬁ To get to the drawing tools use: Tools . Drawing

10
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Each item you digitise is called an "Object" in GIS jargon. This is because digi-
tised items are actually treated as individual entities, each with specific prop-
erties. Most objects have unique identification numbers that allow you to link
them to data. This is also where GIS packages are different from drawing or
CAD packages.

There are three fundamental kinds of objects in a vector GIS namely,
Polygons, Lines and Symbols. A polygon is a closed object, a symbol a point
object and a line, well, a line. You can draw any desired shape with these three
objects.

A note on layers

Practically all GIS packages use a system of layers. Each layer is like a trans-
parency sheet which you can see through. You can pile many layers, one on
top of another and see through them, just like you would on a transparency
sheet. The other similarity is that you can only edit the layer which is on the
top - just as you can only write on the transparency sheet which is at the top.
Layers are necessary in a GIS because they help organising a map. Typically
one uses a separate layer for every type of object. For example if I were to digi-
tise a map of your school, I'd create the following layers:

* Buildings.

* Playground.

* Roads.

* Parking lot.

* School boundary.

This might seem to be a bit of a round about way of doing things. After all,
why can’t we put all these objects on the same layer? Here are a few reasons:

* It would make it difficult for us to create maps which show only one kind
of object.

* Layers make it easy for us to attach non-spatial attributes to objects.

* Layers are easier to work with because they contain only one kind of infor-
mation.

Now let us start playing with the drawing tools:



Digitising a polygon

A polygon is a “closed object” and you draw it by clicking on the polygon tool
and then clicking to create a corner. Clicking on the first point or vertex again
closes the polygon, otherwise click on the right mouse button, the polygon
will close automatically. So if you only click on three corner, you get a trian-
gle and so on.

A polygon style box pops up automatically. This box has three tabs on it, as
shown in figure 2.6.

3
Basics Styies | actions |

detault -

Abc 'l

buift-Lig land
Abc

agricuture

Abe

- weoodland

moarland

Abc ﬂ

Edit project style zet

Figure 2.6
Digitising a polygon

Delete Cancel

In the styles tab you are given the option of picking a preferred colour (each
of which corresponds to a specific land cover). The second tab - Basics (figure
2.7), allows you to allocate a unique ID and label to the polygon. The unique
ID is how the map is linked to a database and corresponds to a field in the
database. More on this later.

=
Bazics ISt'fles I Actions I
Ohject 1816

Figure 2.7 Display label
basic Tab

Unigue ID IObject 1816

12



The final tab - Actions, allows you to control the manner in which the new
object (polygon) behaves in relation to other objects on the screen. This
allows you to control the process of digitising and is a great time saver
because it reduces the amount of editing you need to do later.

Figure 2.8

Actions Tab Eagicsl Styles Actions |

[~elect an action

Snap to live layver

Snap to passive vectar layers
Snap to any vector layers
Subtract izlands

Digitising a line

A line is digitised much the same way as
a polygon, only it is not "closed". You
need to right click the mouse button to Disagaregste mutile polygan
finish digitising a line. On doing so you | ¢yrvert ta ine

are presented with a similar pop up box, | conyert vertices to pairts

as when digitising a polygon. The differ- | c.s with line

ence is that the styles are line styles as
shown in figure 2.9 below.

Figure 2.9
Line Styles

X
Bagics Styles |.-E'u:ti|:|ns|

default e

Digitising a symbol

This is a point object, which implies
bouitt-up land you only need to click once to create
it. On doing so the style box appears
(figure 2.10).

agricutture

Now go ahead and digitise a few
wyoodland polygons, lines and symbols on your
screen. Give each of the objects you
digitise a unique ID and a sensible

mooriznd label. (picture next page)

AKX

Edlit project style set

Cancel




14

Figure 2.10
Point or Symbol Styles GETTING TO KNOW THE MENU
IN MAP MAKER GRATIS
symbol x|
Basics Stvles | actions | The menu, (figure 2.11) , consists
detaul = of six drop down items. We will
ARG go through each briefly. Please note
PoT— that MM offer a wide range of
AEI: actions, not all of which are going to
_ be covered in this course. Also note
T L that a number of features in MM
AlC Gratis are notavailable, however you
¢y Wwoodand can run MapMaker Pro for a month
Abt as a trial.
_GEy maoarland
o = Figure 2.11
Eclt project stvle set The Floating Menu Bar

T . 1o KER =[x
The file menu bar File Edit Mavigate Tools Utiities “Help

The file menu (figure 2.12) is where we
operate on files and directories, or, in GIS jargon, layers and projects. The dis-
tinction is important because a map - the final output, is normally comprised
of a number of layers. In terms of organising these layers, they are normally
saved at a single location a directory, which then corresponds to a project.

The most important items on the file menu are:

Figure 2.12
Clear This removes any objects you might have on the| The File Menu
screen; creates a blank project. Use it [File Edit Navigate Tools Utiities H
carefully because it deletes whatever _
is on the screen Clear - [creste blank project)
' Add layer T+

Add layer Allows you to add a layer Eﬂ? E;rr;}:;ager 0layers Ctr“tﬂ
onto  your screen. Project Open Project Chrle0)
Manager A tool which is used to Save project Sl
organise and display layers. The Save project as
layer manager is perhaps the most Refresh project Cirl+R
complex and useful tool in the pack- =end as e-mai /
age. Page templates *

Save screen image L4
Save screen image Allows you to Print 215.80mms x 279 40mms |

Acrobat Distiller

System set up L4

Exit

1 wigitizsedmapsitest geo
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Exit Exits MM.
MapMaker also shows a list of recently opened projects (*.geo) below the exit
menu.

Figure 2.13 Edit Menu |

|E|:|it Mavigake Tools Ulities He

[ Show Selection Manager

Cut Shift+Del
Copy Citl+inz
Paste Shift+inz
[Delete Dl
Select all

Sawve selection

Cancel selection Ezc

Load file into live layer
Load file into live layer with data

save live layer
Add live layer to...
Clear live layer

[ Draft mode

Live layer options L4
Live layer rubber sheet *
Live layer report

Live layer data 4
Markers L4

Tools Menu
The tools menu (figure 2.15) gives you
control over the various items you use
while digitising and editing maps. Many
of these are available on the tool bar to
the left of your screen. However you
may need to use the menu to access

take a photograph of your screen and save it as an image.

Print Controls printers and printing.

Edit Menu This menu (figure 2.13) presents you with a range of options
with which you edit a layer or project.

The important tools are:

Load file into live layer Loads an exist-
ing (DRA) file into the live layer.

Save live layer Saves the live layer to a
new (DRA) file.

Live layer options A range of options to
facilitate digitising.

Navigate Menu This menu (figure 2.14)
allows you to move around the map. You
will probably use it only if you're digitising
really large maps - such as complete topo-
graphical sheets.

Figure 2.14 Navigate Menu

Mawvigate Tools Uklities Help

Return ta first wiew
Return to previous viesw  Cirl+y
Zoto Object ID

o to co-ordinate

Z0to saved view

Save wiew

by Guide Magp

by Gazetieer

Zoom to extent

Zoomto scale.. 1: 10,000
Screen grid  Automatic

|_ Uze tracker

e
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Figure 2.15 . .
Tools Menus some special drawing tools.

| Tools Utiities Help Let us go through the items.
[ Pointer  Cirl+Del
[ Zoomto box Drawing Various drawing tools.
[¢ Pan Edit Various editing tools.

Gluery » | Map furniture Tools to set up scales, legends and

Measuremert  * | inserting various other objects onto the map.

Drarving k

Ecit * | Utilities Menu
[~ Map furniture The utilities menu| Figure 2.16 Utilities Menu
[ Make extract i,iﬂ?ne etllllcellt yﬁ; ]_thilities —H-EE-
using more than most others (given Dratabaze Utilities /
that most of the drawing and editing Bitmap utilities i’
tools are on the tool bar). Among the Wector Ltilties ’
things it allows you to do are: Latitude and Longitude wutilities k

GPS utilties r

Database utilities Text editor
Access to a range of utilities to create Print Enhanced Metafile (5 amt)
and edit databases linked to the Edit & style file

objects on you map.

Bitmap utilities
Various utilities to edit and modify bitmaps, including scaling.

Vector utilities
Various utilities for importing and exporting vector files and formats.

Text editor
Opens up a text editor.

Print Enhanced Metafile Prints an emf version of the screen.
Help Menu
The final menu, and perhaps the most important during your initial days

using the MM Gratis program. The help menu (figure 2.17) gives you access
to the following items:

What is Map Maker? A brief over view of the programme.
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| Figure 2.17 Help Menu

Help Manual The on-line tutorial for
What iz Map Maker? MapMaker.
hianial . .
Fact sheets Fact sheets A quick overview of the
Library essentials of Map Maker and GIS

& Map Maker weh site concepts. A must read for newbies.

B Useful wek sites

Licences for add-on modules
Abot Map Maker

b . .

Library A utility which allows you
to add various reference material to
the programme.

Useful web sites No explanation needed.

Licences for add-on modules This is where you enter your license key to
activate the MM Pro features of your package. You will have to purchase a
license for this.

About Map Maker Gives you a brief history of the programme and its
authors, version etc.

MAPPING FROM A (FUZZY) SATELLITE PHOTO

We will now open a scanned image from a satellite photo of the Auroville
area. The quality of this photo is rather poor so the quality of the map
will also be a little on the fuzzy side. We will use a better aerial photo in the
next exercise so bear with us.

Here are the commands:

File --> Clear to clear the screen. File --> Add layer : to add a
new layer.

The satellite photo is located in your ~/MM Gratis/work/images directo-
ry and is called nrsal.tif Browse to it and open it using the dialogue as
shown in figure 2.18.

To be able to select it you need to first choose Tagged Image File
Format (bitmap) (.tif) from the upper panel of the dialogue. This will
filter the files in the directory and show you only the tiff files.



Figure 2.18
The File Browser in Map Maker

Choose Tagged Image File Format (bitmap) (*

J| Map Maker Drawing file (* dra)

E Map Maker Location file (* loc)

1| drciew Shape file (*.shp)

|| AutoCAD Data Exchange File (*.dxf)

E Winciowes bitmap (*bmp)

E Tagged Image File Format (bitmagp) (* 1if)
E JPEG Image (* jpg)

3 file:

] A (Backupt) 2 filez of type "fif"

153 kA (bhalla)
----- | DSTcomments
----- | Dumpy

RELTF

[ | wark

[ ) mrt

[} OpenOffice.orgl 1

----- | PatnaGls

..... 1 Phatos j

Use the 50% down arrow on
the scroll bar to move down
the scanned image. You should
now see a couple white circu-
lar areas. The higher larger of
the two is Bharat Nivas, the
smaller of the two is the
Matrimandir. Use the polygon
for each of the sites. Now save
the live layer as aurbldg.dra.

Now draw some lines for roads
and save the layer as roads. Do
the same for fields and forests.

Note: Earlier versions of map
maker had a default setting
here live objects were indicat-
ed by a blue dot. Were the live
layer to be saved, the blue dot
disappeared. This option is
set off in the latest version.

Once you have created all the layers
as above clear the screen using the
File->Clear command. Now we will
build a map using the add layer com-
mand from the file menu, we can
now build up a map of all the layers.
Mine looks like figure 2.19.

MAPPING FROM AN AERIAL
PHOTO

he quality of the last image may-

have left you a little less than
impressed with GIS from satellites.
We will change that perception in this
lesson. If you still have anything on
your screen, use the File-->Clear
command. Now use the File--

Matrfdandic

Figure 2.19
My First Map

18
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>Add Layer command to open a tif called CCRSAREL. This is an aerial photo
shot at 1 meter resolution, but reduced to 4 meter resolution, so you can see
the approximate scale of the IRS 1-C data at its best. To practise, first draw a
few lines to fill in roads layer. Save it.

Now lets use a few techniques to digitise polygons and roads which have com-
mon borders. This feature has been greatly improved in the new version of
Map Maker and is also quite different from earlier versions. There are two
basic techniques to create contiguous polygons. The first, and more intuitive
is to digitise the first polygon normally. The second (and continuous) polygon
is drawn next to it. However before saying OK in the polygon dialogue, go the
the actions tab and select snap to live layer as shown in figure 2.20.

Once you have changed the basic and styles attributes as well, press OK. A
new dialogue pops up which asks you for a snap threshold (figure 2.21).
Select 4 pixels, which tells MM to snap lines which are closer than 4 px.

| Figure 2.20 Digitising Contiguous Borders |Press OK. th

Elasicsl Styles Actionsz |
~elect an action

e

Znap to live layer

Znap to pazzive vector layers
Snap to any vector lavers
Subtract izlands
Dizaggregate multiple polygon

Convert to line (@) Un-sr.lapped polygon -
Convert vertices to poirts | (b) Live Layer Action Box
Cut weith line

V4

snap to live layer x|
" Snap to a maximum distance on the ground of .
|1 0.0 mettes

{* Snap to & maximum distance on screen of .

|4|.D Pixels

4. (a) Snapped polygon
Cancel | Oh I . .
4 (b) Setting the snapping threshold




Settimg

Figure 2.21
Snapping Distances

|

20

Fixels I

e

lines should have snapped together. If this does not work the first time, you
need to edit the object and reset the snap threshold to a higher value.

The second technique that can be used to create polygons uses a neat

feature which essentially automates this snapping process. All you need to do
is set the snapping type and distance in the live layer drawing options (figure
2.22).

I've set the snapping distance to 10, this may be a bit excessive for very
detailed digitising but is OK for those not too comfortable with mice.

MAPPING A SCANNED MAP

File |Edit Mavigate Tools LUkilities

Help
ut ShifDel|
Copy Cirl+ins
Paste Shift+ins
[elete el
Select all
Save zelection
Cancel selection Ezc

[ Show Selection Manager

RIBES

Figure 2.22

Settimg the Drawing Options

Load file into live kayer
Load file into live kayver with data

Save live layer
Add live layer ta...
Cleat live layer

| Live layer options | Wwhen drawing, snap verices to.,
Live layer rubber sheet ¥ [ Show live spots B Snapto grid none L4
Liwe: layer report [ Show live corners [ Selected ohjects

JLive layer data ¥ [ Show live vettices [ Live layer

Markers
[ Draft mode

¥ [ Lse edge editing

|_ [one

Mewy object options
Flaod-fill aptions
Cutter options

Live laver label options
Save options

[~ Passive vector layers

[ Selection and passive layers
[ Live and passive lavers

[ Wertices on click

[ Find vertices when HTICrIg
[ Infill vertices between clicks
[v ertices or lines on click

Snap distance 1000 pixels
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Since one of the primary areas we can get maps from is scanned versions of
paper maps, we will look at the type of info that can be scanned from a
paper map. There are many items from this map that can be scanned:

* roads

* contours
* rivers

* drainages
* towns etc.

Use the tools you have learned so far to create a map of small area of the map.
Create a roads layer, a contour layer, and a rivers layer. When you are done,
we will play with some of the map furniture and other tools.

Setting up scanned files for digitising

Introduction

Calibrating scans is the first thing you do when you take up a project. Ensure
that you have the figures right before you start digitising. It might be well
worth your time and money to hire a field team to verify the coordinates on
the ground and to geo-register the scan for you professionally.

Ten steps to calibrate the scan
Images are calibrated using the : Utilities-->Bitmap utilities--
>Calibrate scan from the Utilities menu (figure2.23).

| Figure 2.23 Calibrating the Scan |

-l
File Edf Havigate Tools | Utiities Help

Database utities 4 { [
| Btmap uiities Actions ' ' I.
ector utities b Wiew bitmap LA P L TR
Latitude and Longitude utitties 4 | Calibrate scan | Single point + known scale
P2 utiities y  Convert file format ¥ Single point + knawn distance
) Fevalve Knowen extent of image
Text editar . .
Frint Enhanced Metafile (* ) el 5 BT
; ; : Wake extract b Wultiple points
Edt 5 =tyle file ) )
; Mosaic and clip [Fre] [}
'! © i Shretchby the four comers : ) ' * )

Step 1.

Select the Single point + known distance option. MM asks you to identify the
file you want to calibrate. Navigate to the images directory and select the
scanned file.



Step 2.
On opening the file, the calibration screen appears which contains the cadas-
tral map of Thuruvai village. Navigate to the scale bar on the map, which is

on the top left of the map.
Step 3.

Use the zoom box tool to magnify the scale bar so it covers the bulk of your

screen.
Step 4.

Select the calibrate icon from the bottom right corner of your screen

Step 5.

Click on the scale bar at the point that corresponds to zero. The dialogue (fig-

ure 2.24) pops up.

Figure 2.24
Selecting initial x and y coordinates.

Calibrate scan |

Image ¥ [229.14 pixels from left

Image v [1805.83 pixels from bottom

il

# ordinate m metres
Y ordinate [9997 6 metres
Cancel | Ok |
Figure 2.25
Set distance from reference point
x

distance I*iUU metres

cers [ o |

Figure 2.26
Specify the calibration type

Choose calibration Eech x|
E.&s part of the file (Map hMaker calibration)

A= a separate "world file"
Az a baseline GeaTiff file

Cancel | )4 I |

Step 6.

Enter the figure O for the X ordinate and
the figure 10000 for the Y ordinate. This
is selected because the scale bar is to the
West and North of the map.

Step 7.

Click on the other end of the scale bar -
which says 400m. Another dialogue ask-
ing you for the distance pops up (figure
2.25). Fill in 400 metres and

press OK.

Step 8.

Map maker now gives you three options
for the kind of calibration technique you
want to use. Select As a baseline Geo-Tiff
file (figure 2.26). This will allow you to
use this scaled map with other programs.

Step 9.
Clear your screen and then reload the cal-
ibrated image.

Step 10.

Test whether the calibration is accurate by
navigating to the scale bargain and using
the tape tool to measure the distance
between 0 and 400 on the scale bar. The
tape should give you the expected figure
of 400.
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EDITING IN MAP MAKER

o matter how well you have digitised a map, it is almost inevitable that
Nyou will need to make changes and improvements on it later. Map Maker
provides a number of useful utilities for editing files. These can be accessed
through the tools-edit menu or through the ctrl-e key combination.
Among the things you can do with the edit tool are:

* Changing the basic object attributes styles, ID numbers and labels

* Basic editing of styles in selected objects

* Moving objects around

* Moving object labels to different locations Cutting objects

* Modifying lines, polygons by adding and moving points, either as lines or as
free form

* Joining objects

* Resizing or scaling objects

* Rotating objects

Using these different features you can achieve most of the basic edit function-
ality you would require while cleaning up and finalising your map.

Steps in editing
Style editing:

Stepl.

Copy the layer you want to edit to the live layer. This can be done from the
File-->Add layer menu or by going to the blue dot near the bottom left
corner of the screen and selecting the copy file to live layer option
as shown in figure 2.27.

Figure 2.27 Step 2.

Copying a file into the live layer Choose Edit from the tool menu or

press Ctrl-E

E':::::|:::::::::§':::::::
Li"f'EIa'j"Er . ....... Steps.

=
]
i
|
T

||Load file int ve layee [ - - - 8- - - -

Click on the object marker (normally

i a blue dot with a thin red outline).

0@ E 9 i i 4@ s The familiar styles box pops up -
| — w— — make the changes you want and click
12007 metras

on OK.



Changing objects

Edit mode:
Double click on the respective objects

Moving labels: Move the label or the object itself (except if it is linked to
nodes).

Interting vertices:
Insert points by clicking on the objects, drag and change the shape.

Scaling:
In case you want to scale the object grab the square handles. The one on the
bottom left or top right to scale along the desired plain.

Rotating:

If you want to rotate the object grab the round handle which is placed in the
top left of the object. You only need to drag is slightly to make it rotate so be
careful.

Cutting:

Cutting objects involves drawing a line within a polygon or line and the object
gets chopped along the new line. You need to use the cutting tool or Tools->
Edit-> cutter for this.

Joining:
Joining is another useful tool which is accessible from the toolbar or from

Tools-> Edit-> Join.

The various editing options available are shown in figure 2.28.

Figure 2.28 Editing objects.

MAP FURNITURE

a

Introduction to map layout

ap Maker provides a number of
tools that enable you to prepare
professional maps. This section cov-
ers these tools which are accessed
through the Tools-->Map

o
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Furniture menu. Even if you have done a brilliant piece of work in digitis-
ing a very large complex topo-sheet, if you can’t present it, it is as good as not
being there. But presenting is not only a skill, it requires aesthetics. There are
some common denominators of a good map.

* Keep the legend so that it is clearly visible but not so large that it distracts
the observer.

* Don’t dump too much info on the same map, use two or more maps instead.

* Always provide locational information, lat and long are fine, but a landmark
or known location such as a nearby city or town might be better.

* A map without a scale has limited use, put at-least an approximate scale
(and indicate that it is approximate).

* Show the directions either through a north point or by arrows giving the
direction to other known landmarks (such as road to XYZ city).

Hints for printing

e If maps are for distribution, ensure that the symbols and polygon colours
can print.

* Colours look much better on a computer screen or for presentations - slides
and OHPs.

* Colour printouts can add lots of life to your documents - use them for pro-
posals or reports to funding agencies, term papers etc.

Map furniture is a set of tools that help you insert various display objects onto
your map. Many of these objects are linked to databases, the various layers on
your map and often to other files and images on your disk. The image below
gives examples of the various things the Furniture Maker does. Using them
judiciously can lead to professional looking maps, using them like I have can
lead to very confused or very angry teachers. Among the items that have been
shown are :

* A Northern point * A project legend
* A scale bar * A legend from a data band file
* A simple text box. * A button (to launch other programmes)



Various other items can be inserted using the map furniture tool. You’ll have
to play around with the tool and get to know them.

Steps in using the Map Furniture tool
¢ Select Tools--> Map Furniture

* Drag you cursor so it makes a box outline which fits the object you want to
insert. Make it long and narrow if it is a scale bar, more of a square if it is a
legend and a tall rectangle if you want to insert a North Arrow.

* The box shown in figure 2.29 pops up. Select any of the furniture types you
want to insert. For each item you select, the furniture dialogue changes to sup-
port various customisation options.

* Change the panel style from the appropriate tab and the location from the
third tab.

¢ Press OK.

You can re-size your box by stretching it in either direction. This is a little non-
intuitive because the outline of the box is not visible. To edit any furniture you
should left click on the item. Hitting the delete key while it is selected will
| delete the selected furniture item.

| Figure 2.29 Map Furniture

x
Furnitutype. [Tite - LINKING FIELD SURVEYS
| TO A GIS
Project legend
spuecos o | Introduction
Text o e e e .
| igitising a map, having all the
ot layers, attaching the database; all
| Abc A - this works out fine if the maps you
‘ S |- work off are accurate. However,. often
maps are outdated and one is not
u - we sure how much the details have
preclletieety changed over time. Even more often,
frone =l the area that you want to map is not
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available. So you need to do actual surveys and transfer this information to a
GIS.

This section is covers conducting a field survey for GIS. The equipment
requiredis a compass and a metertape. If you wan to include heights a sight
level (or dumpy level) will be required. Finally a global positioning system or
GPS will enable you to georeference the field survey. As an exercise we will
generate a map of the school campus.

Simple Survey Methods

The basics of surveying is the ability to locate points in relation to other
points. There are four basic ways of locating a point in relation to other known
points:

* Distance and direction : Measuring the distance and direction of the new
point from a known point.

* Two distances : Measuring the distances from two known points.

* Two directions : Measuring the directions of the new point from two known
points.

* Offset from a line : Measuring the perpendicular distance of the new point
away from a point a known distance from one end of a straight line between
two known points.

We will cover what we consider is the most practical of these methods - dis-
tance and direction. For details of how to do a compass traverse, you need to
refer to the field methods manual.

Processing survey data

Map Maker can create drawings from a text file arranged in a simple format
called the "XY" format. Similarly, Map Maker can export drawing files (.DRA)
to the XY format. The XY format has been designed specifically for entering
simple survey data. Also it can be used to convert a drawing file into numbers
which can be used to set out objects

in the field. The following is an

Map Maker provides you a neat example of surveying the course of a
text editing programme to make stream. From a start point, compass
the creation of ascii files easy. bearings and distances are taken

Access it from the Utilities menu. along the length that has to be sur-
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veyed. Distances can be taken either as tape measures or as step counts.
Here is an example of a compass traverse:
The first number pair of each object is an XY coordinate, subsequent number

COMPASS TRAVERSE

Stream,190,108.06
185,60.05.38
210.5,29.08
274,27.00
314,47.08
326.5,75.05
334,110.03
268,34.08
320,60.02
344,114.09
318,73.20
259,48.11
290,99.11
304,97.09
312,128.08
77,40.08
355,28.11
342,69.08
343,118.00
249,58.06
284,56.11
286,48.07
303.5,67.06
319,111.10

pairs are a compass bearing from the previous point to the next point and the
distance. Pull this into Map Maker and see what it looks like, follow these
steps:

Entering the data:

Enter the data as a simple XY file. Use the Utilities--> Text editor.
We now move to MapMaker and use the Utilities--> Vector utili-
ties --> Import tool (figure 2.30) to translate field data to a vector
layer.
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m:ldx -~ | Figure 2.30 Import an X Y File
File Edit Mavigate Tools | Ukiities Help

Database wilties > | it
Bitmap utilties 4
- | wector utiities Actions : TR
Latitude anel Langitude utilties b Intersectinite files
GPS uilties y  Import files Ml : : 2
z Export files to DXF (ASCH rel. 14)
Uit Generate b toMap Maker Export file
) o
Print Enhanced Metafile (* emf) s Mag Maker LOG fle

Edlit a style file

o Map Maker XY file

to Arciiew Shape file

to Mapinfo MIF

to Idrisi vectar file (* vxp)

to Arcinfa Lngen (*in)

to Aflas GIS (* hna)

to dBaseFoxPro daf with XY
Cirectory of DRA files to zingle DRA, fil

o

Choose the file:
Select the XY file you created by clicking on the button shown in figure 2.31:

| Figure 2.31 Choose File to Import

B
Step 1 of 2: Choose file or directory of files

i Import file

Choose source XY file |

Or...

L Import &l files in a directary

Chogse source directary: |

=T === Preyious step | Hext step === |

Select the XY file:

Select the file you have created by clicking on the Choose source XY file
button. This takes you to the file browser. Choose the XY file and press the
Next Step button.

Name the DRA file to be created:
The second step is similar to the first, only this time you are prompted for the

name of the DRA file you want to create (figure 2.32, next page). Select the
file



Note: the default name is the Complete the import:

same as the name of the XY Press OK and your DRA is created - as
file. This is good because it simple as that. Now clear screen and
helps you keep track of your iew the file. It should look like figure
survey data and maps. 2.33.

Figure 2.32
Name The Target dra File

Xl
Step 2 of 2: Name target

Figure 2.33 The Imported File

Choose target file |

kMMGratizineorkiFisldDatalCompassTraverse dra
CompassTraverse.dra exists and will be over-writen

¥ Preview output before saving

Gt | === Previous step |

WORKING WITH DATABASES

aving gone through the basics map making and digitising, we now turn

to the core of GIS - the ability to visualise spatial data. It is data which
differentiates GIS from other visual tools and graphic packages. The ability to
visually represent information makes GIS what it is today, one of the most
used applications in information technology.

But before we discuss databases, let us create a database for our school. This
will require two steps:

* Creating a database from our DRA file.

* Editing the database to add attributes about the school.

Creating and Editing Databases

In this exercise we will create a database file from an existing .dra file and
then add additional data to the file. First let us convert our digitised map into
a database and add a few fields.

* GotoUtilities-->Database utilities--> Edit Database
if you have already created a dbase file from your layer. If not select Generate
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database from DRA using Utilities-->Database wutilities--
>Generate Database from DRA (figure 2.34). You are prompted for a
DRA file. Browse to the file you generated from the compass traverse.

| Figure 2.34 Database Utilities |

—
Lltilities  Help |

| Databaze utilties | Edit catabase
Bitmap wutilties ¥ Generste databaze from DRA
Wector utilties ¥ Make database extract for DRA,
Latitucde and Longitude wtilities b Updste aress from vector file
GRS Ltilties ¢y Updste lencths from wectaor file
Text editar
Print Enhanced Metafile (* emf)
Edit a style fil=

* Choose your .dbf file if it exists. If you are creating a new .dbf file you will
first have to choose a .dra file from which you want to create it figure 2.35.

Figure 2.35 Database File Browser |

u Choose dBase, FoxPro data file (*.dbf) X

_________________________________________________

dBazefFoxPro data file (* dbf) %
M= Access databasze (*.mdl)

Excel spreadsheet (* x1s)

Comma separated varishles [*.cav)

i & folder (diractary)
i H-[ ] [\ (Backup! ) - |4 files of type "dbf" :
E T ?--k:'x EtI:ZI)"]SE!IIJ:?;rnmerﬂs [#]- Pl clat :
e - Bur ) plots ot :
o j FCRT i) Plats2.thot 5
i 1 MMGratis [#]-thugps.clof 5
E ] Images i
; E-L] MM |
I B wark :
i S} AwDiggt
megmt - :

why computerk: WMGratiseark futorials)




Figure 2.36

Generate Database From DRA Flle * Chose the fields you want the data-

base table to contain. This is illustrat-

Generate database for plots.DRA x| ed in flgure 2.36.

The first and obligstory column is the object ID

* You will now be prompted to save
the file. We are interested in dbf files,
so you should ensure you have the
correct type selected.

Optional automatically filed columns

Dizplay lskel
Area of polygon
Length of line or perimeter of palygon

Style number . LI
Datsbase columns e Click on OK and you have your
o Mew user colurnnl database table created.
R I . 5
Lo ) Figure 2.37 Add Fields
Eclit colurmmn |
fllNew colon x|
Cemee] || o I Field name INEW

Field type |te>d String

* Now go back into the Utilities-
-> Database utilities and edit
the file you just created (figure 2.37).
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Map Maker has a very good interface cancal o
for editing database files. You may, oo |[_ox ]

however, prefer doing so in other programmes such as a spreadsheet
(Gnumeric or Excel). For the sake of this exercise we will stick to MM. Add a
column called LANDUSE using the edit column button and selecting Add col-
umn as shown in figure . Change the field name of the column and the type
to text string in the New column dialogue box. Click OK to save your changes
or click Save As if you want to save your file under a different name. It really
is as simple as that.

Additional suggestions and precautions regarding databases.
There are some precautions you need to take while working with databases.

* Store all the data in a separate folder.

* Name tables intuitively.

* Stick to 8 characters while naming columns or fields.

* Stick to letters while naming fields. No numbers, no punctuation marks, no
symbols.

* Do not use spaces while naming a table or a field.
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"nn

* Use the underscore " " if you must have a space.

* Try to have your data coded into numbers if possible.

Now depending on the mapping exercise and your project, you should add
attributes to your object IDs. Here is an example.

Suppose you have mapped the layout of your school and have the location of
all the rooms on the ground floor. You could categorise the rooms according
to their uses, so you would have

* Classroom

¢ Administrative room
e Staff room

¢ Washroom

* Laboratory

e Other

Each of the above would therefore need to placed on a different layer. Once
you ‘ve done that, proceed with adding data to the classroom layer. The fields
could be:

* Standard
* Number of students
* Average age of the student

Add this data to the database table using the MM data base editor. Once
you ‘ve done that you are set to create thematic maps.

THEMATIC MAPPING

hematic maps are maps which show a non-spatial attribute on a map. For
Texample the states of India can be coloured according to their populations.
For the sake of our exercise, we will use the classroom.dra file that you creat-
ed in the previous example.

Linking the data to a dra file

* Clear the screen.

* Add a layer using the File-->Project Manager and pressing the Add layer-
button.

* Click the Assign according to tab on the style tab of the layer set up as
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shown in the figure.

* Click on Database. The dialogue shown earlier pops up.

* Select your database (classroom.dbf), the choose link column shown in the
figure below pops up.

* Select the ID column (id). This is the column that links each object on your
DRA file to an entry on your database.

* Select the column titled -No_Students for the style.
* Press OK.

NOTE: None of the database
functionality of MM will
work if you don’t select the
correct link.

Voila, you have your first thematic map. You can generate a number of the-

matic maps and have many ways to depict data in MapMaker. We leave it to
you to explore these.
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Chapter 3:

Wrapping up

SOME EXERCISES

The best way to master Map Maker is to use it. Here are some exercises you
can do in your spare time, or as a project. They require some work but you
will probably find them quite interesting.

Mapping the school campus
You should already have collected much of the data for this. Now you need to
transfer it onto MapMaker and add some data to the digitised objects.

Here are some suggestions.

Buildings
Differentiate them into academic, administrative and logistics.

Open areas

Categorise them into playgrounds (cricket, football, hockey etc.) courts bad-
minton, basketball, tennis etc.) and others which might include garden areas,
ponds etc.

Roads
Break these up according to the traffic and nature of roads.

A street map of your locality

Map the streets around your house. A compass traverse is an ideal way to do
this. You can then add a range of data to this map. For example the various
buildings, shopping centres, playgrounds etc. Such a map can help you
answer some interesting questions such as:

* What is the distance of your bus stop from the house?
* Which milk shop is closeset to the house?
* What is the shortest way to get to the house from any given point?



You can use this map to design a walk for your parents, if they like going out
for morning or evening walks. They ‘1l surely be interested in knowing ex-actly
how many kilometres they walk in a day.

Digitising Pondicherry

Here is a really big project, which you can do with your classmates. Each of
you can take a portion of the city to digitise. It would make sense if this por-
tion is where you actually stay. Once the map is done, you can use it for var-
ious things. Here are a few questions you can answer.

* How many kilometres do you travel to school and back every day?

* If you were to organise a school bus or van to pick up students, what route
would it follow to pick up the maximum number of students and yet stick to
the main road?

* How far are you from the main market, Gandhi statue, JIPMER, Ousteri and
other areas of interest to you?

FOLLOW UP

he purpose of the manual is to introduce you to vector GIS. You should be
Tcomfortable in the use of Map Maker now and we hope you use what you
have learned in your various school and classroom projects. We have made a
copy of the MapMaker programme available to your school, feel free to make
more copies and distribute them. If you have a computer at home, we encour-
age you to load MapMaker on it. The programme is quite small. If you have
any trouble with the programme, do e-mail us at feral@satyam.net.in.

We hope you keep in touch with us and keep us informed about the way in
which you have used the manual.
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